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VOCATIONAL DIPLOMA EXAMINATION –   

DECEMBER 2020 

ADOBE PHOTOSHOP 

Time : 3 hours Maximum marks : 75 

PART A — (5 × 5 = 25 marks) 

Answer any FIVE questions. 

1. Discuss about Working with image files. 

 

2. Explain the purpose of positioning tools and 

presets. 

 

3. Discuss the process of creating and deleting a 

layer. 
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4. What is meant by flattening the image? Explain in 

detail. 

 

5. Discuss how to change quick mask options. 

 

6. Briefly explain the paint bucket using photo 

techniques. 

 

7. Describe the erasing image content and adding a 

gradient. 

 

8. Write the steps involved in correcting image color. 
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PART B — (5 × 10 = 50 marks) 

Answer any FIVE questions. 

Question No. 9 and 10 are compulsory. 

9. (a) To get Desaturate option in Photoshop, we 

have to go to 

  (i) File Menu 

  (ii) Layer Menu 

  (iii) Image > Adjustment 

  (iv) None of the above 

  Photoshop-

  (i) 

  (ii) 

  (iii)  >

  (iv)  

 (b) To get Auto contrast option in Photoshop, 

select 

  (i) Filter Menu 

  (ii) Image>Adjustment 

  (iii) File Menu 

  (iv) None of the above 
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  (i) 

  (ii)  >

  (iii) 

  (iv)  

 (c) How many Color Modes are there in 
Photoshop? 

  (i) Five 

  (ii) One  

  (iii) Three 

  (iv) None of the above 

 Photoshop-

  (i) 

  (ii) 

  (iii) 

  (iv)  

 (d) How many types of Gradient are there in 
Photoshop? 

  (i) Five 

  (ii) Two 

  (iii) Six 
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  (iv) Three 

 Photoshop-

  (i) 

  (ii) 

  (iii) 

  (iv)  

 (e) To get Stroke option in Photoshop. We have 
to select  

  (i) Select menu 

  (ii) Filter Menu 

  (iii) Edit Menu 

  (iv) None of the above 

 Photoshop-

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (f) Who developed Adobe image ready? 

  (i) Adobe systems 

  (ii) Citrix systems 
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  (iii) Cisco systems 

  (iv) Microsoft 

  Adobe-

  (i) 

  (ii) 

  (iii) 

  (iv)  

 (g) GIF stands for 

  (i) Graphical Internet File 

  (ii) Graphic Included Format 

  (iii) Graphics Interchange Format 

  (iv) None of the above 

  GIF

  (i) 

  (ii) 

  (iii) 

  (iv)  

 (h) Blurs edges by building a transition 

boundary between the selection and its 

surrounding pixels is known as 

  (i) Anti-aliasing 
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  (ii) Feathering 

  (iii) Healing 

  (iv) None of the above 

 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (i) By default, how many channel Indexed color 

images are there? 

  (i) One Channel 

  (ii) 255 Channel 

  (iii) 216 Channel 

  (iv) 256 Channel 

 

  (i) 
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  (ii) 255  

  (iii) 216  

  (iv) 256  

 (j) In Photoshop, maximum how many alpha 

channels can create in an image? 

  (i) 20 

  (ii) 22 

  (iii) 24 

  (iv) 26 

  Photoshop-

 

  (i) 20 

  (ii) 22 

  (iii) 24 

  (iv) 26 

10. State True or False : 

 (a) Liquify is a Filler. 
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 (b) We can find Variation option under Filter 

menu in Photoshop. 

  Photoshop-

 

 (c) The short cut key of Feather is  

Alt + Ctrl + F. 

 Alt + Ctrl + F

 (d) We cannot import jpeg image in Premiere. 

 jpeg

 (e) We use Lasso Tool for selection. 

 

 (f) We cannot save any Selection in Photoshop. 

 Photoshop-

 (g) If R = 255, G = 0, B = 0, the colour will be 

black. 



 VDIP-C-289

  

10 

 R = 255  G = 0  B = 0

 

 (h) The default color mode of Photoshop is 

CMYK. 

 Photoshop-

CMYK

 (i) The full form of RGB is Red Green and 

Black. 

  RGB-  

 (j) Photoshop is an Image editing software. 

  Photoshop

 

11. Discuss about the selecting image content and 

change a selection. 

 

12. Explain the arranging layer order, grouping and 

ungrouping layers. 

 

13. Discuss how to use layer mask and putting a mask 

to work. 
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14. Explain about creating paths and using clipping 

paths. 

 

15. Discuss the changing the canvas size and rotating 

and trimming the Canvas. 

 

16. Explain about the working with actions and 

creating web images. 

 

 

––––––––––––– 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

ANIMATION 

ADOBE PHOTOSHOP 

Time: 3 Hours            Maximum Marks: 70 

PART –A     (3 x 3 = 9 Marks) 

Answer any Three questions out of Five questions in 100 words. 

All questions carry equal Marks. 

1. What is a Smart Object in Adobe Photoshop? 

2. Explain the Merge Visible 

3. Explain the Neon Effects 

4. Explain about Lasso tools in Photoshop? 

5. What is a heal tool? 

 

         PART –B             (3 x 7 = 21 Marks) 

Answer any Three questions out of Five questions in 200 words. 

All questions carry equal Marks. 

  

6. Explain Histogram in Photoshop 

7. How to organize layers in Adobe Photoshop? 

8. What magic wand tool does? 

9. Write a short note on   

(a) Drop shadow, (b) Inner shadow, (c) Gradient Overlay  

10. Difference between RGB & CMYK color mode? 

PART –C              (4 x 10 = 40 Marks) 

Answer any Four questions out of Seven questions in 500 words. 

All questions carry equal Marks. 

11. What is the quickest way to achieve this? Multiple Layers? Layer Masks? 

12. What is Filter? Write any five Filters and its applications. 

13. Create a Poster for a PSA on “Save  Water”. 

14. What is a camera raw filter and its purpose? 

15. Explain process of cutting image with flying hair? 

16. What is Puppet warp tool and its uses? 

17. What are the Editing tools and explain? 
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VOCATIONAL DIPLOMA EXAMINATION  

DECEMBER 2020 

Animation 

MACROMEDIA FLASH – ADVANCE DESIGN 

Time : 3 hours Maximum marks :75 

PART A — (5  5 = 25 marks) 

Answer any FIVE questions. 

1. Describe the uses of TIME LINE and Layer panel 

in flash. 

2. How to Change background colour and Stage size? 

3. Define MASK layer in flash. 

4. Explain Shape command and Align command. 

5. How to create a path tween in flash? 

6. Difference between Normal web page and 

Dynamic web page. 

7. How to Embed Flash in html'? 
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8. Explain Drawing Toolbar. 

PART B — (5  10 = 50 marks) 

Answer any FIVE questions. 

Question No.9 and 10 are compulsory 

9. (a) A frame that has no drawing on it. 

  (i)  Input Text 

   (ii)  Motion Presets 

       (iii) Animation spin 

          (iv) Empty Frame 

 (b)  The number of picture displayed in a second 

in Flash? 

       (i)  Static Text 

        (ii)  Bones 

        (iii)  FPS (frames per second) 

        (iv)  Frame 

 (c)  A GUI object one can press or click to trigger 

some function. 

       (i)  Frame-by-frame Animation 

        (ii)  Motion Tween 

        (iii)  Button 
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        (iv)  Function 

 (d)  The programming language that goes with 

Flash? 

       (i)  Variable 

       (ii)  Action Script 

   (iii)  Key Frame 

   (iv)  .SWF 

 (e)  Movie Clip - Button and Graphic are? 

   (i)     Symbol Types 

   (ii)    Library Panel 

  (iii)   URL 

   (iv)    Video Formats 

 (f) This panel indicates what settings are being 

used for objects and allows you to change 

those settings? 

  (i)     Tools 

   (ii)    Actions 

          (iii)    Frames 

          (iv)    Properties 

 (g)  A building block of an animation. 

  (i)  Motion Guide 

  (ii) Adobe Media Encoder 

  (iii)   Frame 
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  (iv)    Empty Frame 

 (h)  Animation where objects change in each 

frame 

          (i)  Merge Drawing 

  (ii)  Stage 

  (iii)  Properties Panel 

  (iv)  Frame-by-frame Animation 

 (i) Contains Action Script code 

          (i)   Motion Path 

          (ii)     AS - Action Script File 

          (iii)    Motion Tween 

          (iv)     Event Listener 

 (j)  Something that you drag to move to indicate 

your current frame. (Orange/Red in color). 

  (i)  Import Graphic 

        (ii)  FPS (frames per second) 

   (iii) Toolbar 

  (iv)   Play head 

10. State True or False: 

 (a)  Files in .swf format can be edited in the 

Flash program. 

 (b)  The Window menu on the menu bar cannot 

be used to display and hide panels. 
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 (c)  You can learn several things about a movie 

by studying the timeline. 

 (d)  Frames in a Flash movie are similar to 

frames in a motion picture. 

 (e)  The size of the Stage is equivalent to the size 

of the area within your browser window that 

displays the movie. 

 (f)  You cannot animate an objects appearance. 

 (g)  Panels are used to modify objects and 

features in a movie. 

 (h)  Colours and symbols are used to indicate 

types of frames. 

 (i)  A storyboard includes placeholders for 

various elements of a user interface. 

 (j)  Gradient swatches does not appear in the 

Fill color control. 

11. Explain the types of Animations and its uses in 

Flash. 

12. What are the panels available in flash window? 

13. Explain the Import and Export file formats in 

Flash. 
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14. Discuss the guide layer and Masking Text in 

detail. 

15. What are the sound file import formats in flash? 

How will you add sound to button? 

16. Explain the different tools in the Tool Box. 

———————— 



 

 

 

 

VOCATIONAL DIPLOMA EXAMINATION - DECEMBER 2020 

ANIMATION 

MACRO MEDIA FLASH-ADVANCED DESIGN 

 

Time: 3 Hours       Maximum Marks: 70 

Section A (3 x 3 = 9 Marks) 

Answer any THREE questions out of Five questions in 100 words. 
All questions carry equal marks. 
 
1. Difference between Shape Tween and Motion Tween with the help of an example? 

2. How to Change background colour and Stage size? 
3. Explain Shape command and Align command? 

4. Explain Drawing Toolbar. 
5. How to create a path tween in flash? 

 

Section B (3 x 7 = 21 Marks) 

Answer any THREE questions out of Five questions in 200 words. 
All questions carry equal marks. 

6. Describe the uses of TIME LINE and Layer panel in flash? 
 

7. How to move Objects along a Path and describe with example? 
 

8. Difference between Normal web page and Dynamic web page. 
 

9. Explain the Flash vs. Animated Images and Java Applets. 
 

10. How to Embed Flash in HTML? 
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Section C (4 x 10 = 40 Marks) 

Answer any FOUR questions out of Seven questions in 500 words. 
All questions carry equal marks. 

11. Write about the different ways for editing symbols in Flash? 
 

12. Describe the use of various Drawing tools in Flash? 
 

13. Explain the Import and Export file formats in Flash. 
 

14. Explain the types of Animations and its uses in Flash. 
 

15. Explain the different tools in the Tool Box. 
 

16. Discuss the guide layer and Masking Text in detail. 
 

17. How will you create a Text animation using Masking effect explain the in detail? 
 

 

 

 



  

 

 

VOCATIONAL DIPLOMA EXAMINATION – 

DECEMBER - 2020 

VIDEO EDITING PROCESS AND 3D COMPUTER 

GRAPHICS AND MODELING  

Time: 3 Hours Maximum Marks: 75 

PART A (5  5 = 25 Marks)  

Answer any FIVE questions. 

1. Explain the Video Capture Tips and Options. 

 

2. Discuss about importing Premiere and Illustrator 

Files. 

 

3. Describe the Changing Clip Duration and Speed. 
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4. What is Slip and Slide Edits? Explain in detail. 

 

5. Explain the Title Backgrounds and Video Safe 

Zones. 

 

6. Discuss Applying and Controlling Standard 

Effects in audio.  

 

7. How to Automat Audio Mixing? 

 

8. Explain the Adobe Media Encoder Presets. 
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PART B (5  10 = 50 Marks)  

Answer any FIVE questions. 

9. Choose the Correct answer :  (10  1 = 10) 

 (a) The pixel/line of DVD are 

  (i) 240 

  (ii) 720 

  (iii) 1024 

  (iv) None of the above 

  DVD  

  (i) 240 

  (ii) 720 

  (iii) 1024  

  (iv)  

 (b) Image editing Tool features are 

  (i) Multiple windows 

  (ii) Masking feature 

  (iii) Antializing capability 
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  (iv)  All of the above 

   

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (c) Sonogram is 

  (i) Method of speech recognition 

  (ii) Method of 3D display 

  (iii) Method of picture creation 

  (iv) Method of transferring data  

   

  (i)  

  (ii) 3D  

  (iii)  

  (iv)  

 (d) Which of the following is not a video 

compression technique? 

  (i) Interpolative  

  (ii) Predictive 
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  (iii)  Transform 

  (iv) All of the above 

  

 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (e) Which technique is used to show the 

structure of three-dimensional object? 

  (i) Prespective projection 

  (ii) Simple projection 

  (iii) Parallel projection 

  (iv)  None of the above  

  

 

  (i)  
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  (ii)  

  (iii)  

  (iv)  

 (f) Which technique is used to convey the depth 

and shape of an object on raster scan 

display?  

  (i)  3D image 

  (ii) Polarizer 

  (iii) Kinetic depth effect 

  (iv)  Shading with hidden surface removal 

  

 

  (i) 3D  

  (ii)  

  (iii)  

  (iv) 

 

 (g) Which of the following is used to record the 

structure of a scene? 
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  (i) Geometry  

  (ii)  Topology 

  (iii) Image 

  (iv) None of the above 

  

 

  (i)  

  (ii)  

  (iii)  

  (iv)  

 (h)  Which input device is used to work on flat 

surfaces? 

  (i) Tablets 

  (ii)  Mouse 

  (iii)  Stylus 

  (iv)  None of the above 

  

 

  (i)  

  (ii)  

  (iii)  

  (iv)  
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 (i)  Which of the following is a pointing device? 

  (i)  Tablets 

  (ii) Mouse 

  (iii) Light Pen 

  (iv)  Stylus 

   

  (i)  

  (ii)  

  (iii)  

  (iv)   

 (j) What is Refresh Rate? 

  (i) Number of frames scanned per second 

  (ii) Number of picture deleted per second 

  (iii) Number of frames audio Is added per 

second 

  (iv) None of the above 

   

  (i) 
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  (ii) 

 

  (iii) 

 

  (iv) 

10. State True or False :   (10  1 = 10) 

 (a) Camera work is at the center of video 

production. 

 

 (b)  Editing is the process of cutting out the bad 

parts.  

  

 

 (c) Most major news shows, like 60 Minutes. 

have edited together shots taken at different 

times. 

  

 



 VDIP-C-291 

 
10 

 (d) You should always film things coming and 

going from the same direction during one 

sequence. (all right to left). This is called the 

180 degree rule. 

  

 

 (e) Allowing the actors (or objects) to leave and 

re-enter the frame can solve issues related to 

screen direction. 

  

 

 (f) Bad editing can ruin a good movie. 

 (g) When you trim an edit point you are 

lengthening or shortening the clip either at 

the head or the tall?  

 (h) You can add markers to a clip in the viewer 

window. 
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 (i) Command–V pastes clips as an insert edit. 

  V

 (j) The keyboard shortcut K is used Play clip or 

sequence forward. 

  

K

11. Explain the Monitor Window Playback Controls. 

 

12. Discuss about Editing clips In the Timeline. 

 

13. What is Transitions? How to Applying Transitions 

Automatically? 

 

14. Discuss about Modifying Shape Objects and 

Custom Styles. 

 

15. How Premiere Processes Audio and Audio Sends 

and Submixes? Explain. 
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16. Explain about the Exporting Single Fames and 

Audio. 

 

_______________ 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

ANIMATION 

VIDEO EDITING PROCESS AND 3D COMPUTER GRAPHICS AND MODELING 

Time: 3 Hours               Maximum Marks: 70 

PART –A      (3 x 3 = 9 Marks) 

Answer any Three questions out of Five questions in 100 words. 
All questions carry equal Marks. 
1. What are the panel tools? 
2. How to export the files for web and mobile devices 

3. What is import batch list? 
4. Elaborate the options of marker? 

5. What is “AVCHD” and elaborate? 
 

PART –B              (3 x 7 = 21 Marks) 
Answer any Three questions out of Five questions in 200 words. 

All questions carry equal Marks. 
6. Describe the video standards? 

7. Elaborate the differences of masking and tracking. 
8. What are the video codecs for exporting? 

9. How to create a title and motion graphics? 
10. What is alpha channel and matte? 

 

PART –C             (4 x 10 = 40 Marks) 
Answer any Four questions out of Seven questions in 500 words. 

All questions carry equal Marks. 
11. Discuss and differentiate the audio master meters and audio mixer. 

12. Elaborate the capturing time code. 
13. Discuss the different monitors with their tools. 

14. How to render a section of sequence? 
15. What are the panels available in flash window and explain in detail. 

16. Enumerate the effective techniques of video editing. 
17. Explain the norms in capturing and digitizing. 
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